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Startup and About 
END-USER LICENSE AGREEMENT (TRIAL, FULL VERSION)  
  
BY RECEIVING AND/OR USING 4TEAM CORPORATION (ALITTERA LTD INC DBA) USER LICENSE AGREEMENT 
YOU ACKNOWLEDGE THAT THIS IS A BINDING LEGAL AGREEMENT BETWEEN ALITTERA LTD INC. AND USERS OF SOFTWARE AND 
PRODUCTS BELONGING TO 4TEAM CORPORATION, A DBA NAME OF ALITTERA LIMITED, INC. 
IF YOU DO NOT INTEND TO HONOR THIS AGREEMENT, PLEASE TERMINATE THE SOFTWARE INSTALLATION NOW. 

  
DISCLAIMER 
THIS WEB SITE AND THE MATERIALS AND PRODUCTS IN THIS WEB SITE ARE PROVIDED "AS IS" AND WITHOUT WARRANTIES OF 
ANY KIND, WHETHER EXPRESSED OR IMPLIED. TO THE FULLEST EXTENT PERMISSIBLE PURSUANT TO APPLICABLE LAW (AND, 
THEREFORE, THE FOLLOWING MAY NOT APPLY TO YOU), 4TEAM CORPORATION DISCLAIMS ALL WARRANTIES, EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. 4TEAM CORPORATION DOES NOT REPRESENT OR WARRANT THAT THE FUNCTIONS CONTAINED IN THE WEB SITE WILL 
BE UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS WILL BE CORRECTED, OR THAT THIS WEB SITE OR THE SERVER THAT MAKES 
THE WEB SITE AVAILABLE ARE FREE OF VIRUSES OR OTHER HARMFUL COMPONENTS. 4TEAM CORPORATION DOES NOT MAKE ANY 
WARRANTIES OR REPRESENTATIONS REGARDING THE USE OF THE MATERIALS IN THIS WEB SITE IN TERMS OF THEIR 
CORRECTNESS, ACCURACY, ADEQUACY, USEFULNESS, TIMELINESS, RELIABILITY OR OTHERWISE. 

  
RIGHT TO USE AND DISTRIBUTE THE SOFTWARE 
4TEAM CORPORATION, IN ACCORDANCE WITH THIS AGREEMENT, GIVES YOU THE RIGHT TO: 
TRIAL VERSION: USE AND DISTRIBUTE THIS SOFTWARE FOR YOUR PERSONAL OR BUSINESS PURPOSES ONLY AMONG YOUR 
COMPANY (TEAM) MEMBERS FOR 14 DAYS PERIOD. YOU ARE ALLOWED TO INSTALL AND OPERATE THIS SOFTWARE ON YOUR 
COMPUTER SYSTEM.  IT IS ASSUMED THAT YOU ARE USING THE SOFTWARE AS SOON AS IT IS STORED IN YOUR SYSTEM'S MAIN 
MEMORY OR ANY OTHER DATA STORING DEVICE.  
FULL VERSION: USE AND DISTRIBUTE THIS SOFTWARE FOR YOUR PERSONAL OR BUSINESS PURPOSES ONLY AMONG YOUR 
COMPANY (TEAM) MEMBERS. YOU AND YOUR COMPANY (TEAM) MAY USE ONLY THE NUMBER OF COPIES THAT YOU HAVE 
PURCHASED FROM 4TEAM CORPORATION OR ITS DISTRIBUTORS AND THAT IS GRANTED BY THE LICENSE. WHEN THIS SOFTWARE 
IS STORED IN YOUR SYSTEM'S MAIN MEMORY OR OTHER STORING DEVICES, IT IS ASSUMED THAT "YOU ARE USING THE 
SOFTWARE". 

  
THE TRIAL VERSION MAY BE FREELY DISTRIBUTED, PROVIDED THAT SUCH DISTRIBUTION INCLUDES ONLY THE ORIGINAL ARCHIVE 
SUPPLIED BY 4TEAM CORPORATION. YOU MAY NOT ALTER, DELETE OR ADD ANY FILES IN THE DISTRIBUTION ARCHIVE. 

  
COPYRIGHT 
THE COPYRIGHT AND INTELLECTUAL PROPERTY RIGHTS OF THIS SOFTWARE AND ANY ATTACHMENTS TO THIS SOFTWARE ARE 
OWNED BY 4TEAM CORPORATION, AND PROTECTED BY THE COPYRIGHT LAWS OF THE STATE OF FLORIDA, USA, AND 
INTERNATIONAL INTELLECTUAL PROPERTY RIGHT TREATIES. THEREFORE, YOU CANNOT COPY ANY PORTION OF THIS SOFTWARE IN 
ANY FORM, EXCEPT FOR USING OR COPYING IT FOR BACKUP PURPOSES. ALSO, YOU CANNOT TRANSFORM THE CONTENTS OF THE 
SOFTWARE OR CHANGE THE FILE NAMES. 

  
LIMIT OF WARRANTY 
4TEAM CORPORATION DOES NOT WARRANT THAT USING THIS SOFTWARE WILL FIT ALL USERS’ PARTICULAR PURPOSES, AND IS 
NOT LIABLE FOR ANY DAMAGES CAUSED BY THE USE OF THIS SOFTWARE. 

  
SUPPORT 
4TEAM CORPORATION IS SOLELY RESPONSIBLE FOR CUSTOMER SERVICE. EVERY EFFORT SHALL BE MADE TO PROVIDE A SOLUTION 
FOR TECHNICAL QUERIES ABOUT PROBLEMS CAUSED BY THE INSTALLATION OR USE OF THE SOFTWARE INSTALLED IN A USER'S 
SYSTEM. ALL CUSTOMER SERVICE MATTERS SHALL BE DEALT WITH ONLY VIA E-MAIL, QUESTIONS MUST BE ADDRESSED TO 
support@4team.biz. ANY QUESTIONS, COMPLAINTS, COMMENTS OR SUGGESTIONS SHOULD BE SENT TO sales@4team.biz 

  
ACKNOWLEDGEMENT 
HAVING READ AND UNDERSTOOD THIS USER LICENSE AGREEMENT, YOU ACKNOWLEDGE ITS PRIORITY TO ANY ORDER, 
ENGAGEMENT OR ADVERTISEMENT, AND AGREE TO ITS TERMS. 
IF YOU AGREE WITH THIS USER LICENSE AGREEMENT AND WISH TO CONTINUE WITH THE SETUP, PLEASE PRESS 'YES', IF YOU 
DISAGREE AND WISH TO CANCEL THIS SETUP, PLEASE PRESS ”NO”. 
ALITTERA LTD INC. 4TEAM CORPORATION 2010© ALL RIGHTS RESERVED  

mailto:support@4team.biz�
mailto:sales@4team.biz�
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Introducing Plug2Sync 
  
What is Plug2Sync? 
Plug2Sync is a personal, as well as a workgroup tool, and a downloadable PC application that allows you 
to synchronize your files and Microsoft Outlook data between desktops, laptops and external drives using 
external USB memory devices (hard drives, memory cards, flash sticks, etc.) or any other connected 
drives. 
If you are looking for a quick and easy way of synchronizing Microsoft Outlook** folders' data and files 
on multiple PCs, this program is for you. You just need to install Plug2Sync on your computers and on 
computers of your preferred teammates, and after a few steps you will be ready*** to have fully 
synchronized file folders and Microsoft Outlook folders that will look the same on all synchronized 
computers. All changes will automatically propagate to the synchronized folders after each 
synchronization, even without opening Microsoft Outlook, and can be scheduled or made manually. You 
can use sophisticated and easy-to-use filters to synchronize only the data of your choice (i.e. excluding 
personal or private information; data for selected period, by labels or categories, etc.) The Microsoft 
Outlook synchronization is done via pst files that can be used as backup and can be restored on other PCs 
even if Plug2Sync is not installed. 
  
What are the benefits of Plug2Sync? 
Plug2Sync enables you to make the files and Microsoft Outlook synchronization between PCs fully 
automated, quick and convenient. No more copying of all that data from computer to computer. Among 
other benefits, are the following: 
 Bidirectional files and Microsoft Outlook synchronization. Automatically detect and synchronize 

creation, deletion, and all other changes, made by the user in files and Outlook items. 
 Automatic external device recognition and sync on connect (reconnect). If you have already 

synchronized the data with your external drive before, just connect it to your PC to start 
synchronization. 

 Ability to select and sync only data that you want: Exclude and Include Filters. 
 Instant synchronization of changed data to your external (backup) drive, which means no waiting for 

any backup or synchronization to end - just safely remove your external drive and go. 
 Portable* application means that you can install Plug2Sync onto an external removable drive and just 

need to connect it to your PC in order to start synchronization. 
 Instant, scheduled or manual automatic background synchronization, even if Outlook is not running. 
 The state-of-the-art application that works directly with MAPI without interference with your Outlook. 

There are no add-ons/plug-ins to install. 
 Event-based**** synchronization, only changes are transferred to your external backup drive! 
 Assigned external drives. Synchronization settings are assigned to each drive, which  makes it easy 

to synchronize different groups of PCs with different sets of folders, schedules, filters, and other 
settings. 

 Use synchronization of selected folders and assigned external drives for sharing purposes with other 
users (friends, coworkers, family) 

 Use Plug2Sync to back up your files and Outlook data, to easily restore it at any time or create a 
clone to migrate the data to a new or reformatted computer. 

*Portable application will be added later in 2010. All users who have purchased non-portable version will 
receive the updated version for free. 
**Microsoft Outlook must be installed on the PC in order to synchronize its data files (PST) 
***The actual synchronization time will depend on the size of the synchronized folders and on the speed 
of the external device. 
****Instant mode only 

 How it works 
 Features 
 Installation 

Plug2Sync website 
  

http://www.plug2sync.com/�
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How to buy/ Register / Trial Version Expired 
How to continue trial 

Your trial version expires in 14 days. 

If you do not renew (activate) the trial version that is about to expire, you will not be able to use 
program. It is necessary to purchase the license to make the program work without any limitation. 

Buy Now and you will receive: 

• 1 year of free updates. 

• 1 year of free tech support via e-mail and live help. 

  

Click here to Buy Plug2Sync. 

(http://www.4team.biz/purchase_plug2sync.asp) 

  

Have a Question? 

Please call: +1 (954) 796-8161 or click here to Ask Question Now. 

FREQUENTLY ASKED QUESTIONS 

Product Activation 

Support  

http://www.4team.biz/purchase_plug2sync.asp�
http://www.4team.biz/purchase_plug2sync.asp�
http://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1'%20target='chat12138912&sessionkey=H4659946961740398489K4129059�
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How Plug2sync Works 
  
This is a powerful state-of-the-art and easy to use synchronization application that works directly with 
Windows MAPI without interference with Microsoft® Outlook®. The system works without a central server 
or database and their role is played by data folders that can be placed in any accessible device (e.g.: USB 
Flash, memory cards, USB external drives, etc.). You need to install the program on all PCs that you plan 
to synchronize. Plug2Sync will detect and track any changes made in files and Microsoft Outlook folders 
and publish them in the data folder on the removable drive. Plug2Sync will also pick up synchronized files 
and Outlook data changes published by Plug2Sync from other PCs, compare them to avoid conflicts and 
duplication, and add this data to your PC. To simplify synchronization, we have assigned all settings to 
each physical removable drive including synchronized Outlook and files folders, filters, schedules and all 
PCs that participate in synchronization, as well as other settings. You can create as many external drives 
as you want, that will help you synchronize different groups of PCs, with different people, different 
settings and data.  
Because Plug2Sync records changes made in your files and Outlook to the local Plug2Sync database, you 
will be able to work offline (when your removable backup drive is not connected). After you are able to 
connect the removable drive to your PC, Plug2Sync will automatically reconnect and update your files and 
Outlook data applying your updates to the data folder in the removable drive. The Microsoft Outlook 
synchronization is done via pst files that can be used as a backup and be restored on other PCs even if 
Plug2Sync is not installed. In the Instant synchronization mode (default), all your changes will be 
instantly published in the connected removable drive and you will able to safely remove it without any 
waiting as in other backup-synchronization scheduled solutions. Using Plug2Sync as a portable* 
application gives you freedom: you do not need to install the application on your PC, just install it on your 
removable drive, and start synchronization from it immediately or on connect to your PC. 
  

Plug2Sync website 

http://en.wikipedia.org/wiki/Messaging_Application_Programming_Interface�
http://www.plug2sync.com/�
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Features 
Click on the underlined links. 
For the latest release notes, check the What's New section. 

 Bidirectional files and Microsoft Outlook** data synchronization. Automatic detection and 
synchronization of the creation, deletion, and all other changes, made by the user in files and 
Outlook items. Plug2Sync automatically analyzes, synchronizes, and backs up your e-mails, 
precious photos, contacts, tasks, MP3s, documents, and other files of your choice. 

 Automated external device recognition and sync on connect (reconnect). If you have 
already synchronized the data with your external drive before, just connect it to a PC in order to 
start synchronization. 

 Select and sync only data that you want: Exclude and Include Filters.  
 Instant synchronization of changed data to your external (backup) drive, which means no 

waiting for any backup or synchronization to end - just safely remove your external drive and go. 
 Portable* application means that you can install Plug2Sync onto an external removable drive 

and just connect it to your PC in order to start synchronization. 
 Instant, scheduled or manual automatic background synchronization even if Outlook is 

not running. 
 The state-of-the-art application that works directly with MAPI without interference with 

your Outlook. There are no add-ons/plug-ins to install. 
 Event-based synchronization, only changes are transferred to your external backup drive! 
 Assigned external drives. Synchronization settings are assigned to each drive, which makes it 

easier to synchronize different groups of PCs with different sets of folders, schedules, filters, and 
other settings.  

 Synchronize Microsoft® Outlook® on multiple PCs 
Computer1 + Plug2Sync<-> External drive <-> Computer2 + Plug2Sync. Synchronize (Clone) 
your Outlook personal folders: Calendars, Contacts, Tasks, E-mails with your second desktop or 
laptop without Exchange Server. You can automatically synchronize Outlook between several 
computers without limitations. No complicated wizards to complete afterwards you can just 
connect your external drive to initiate synchronization, or schedule your synchronization, or do it 
manually, by your request. Synchronize as many PCs as you want. 

 Synchronize any selected or all Outlook Personal Folders and all Outlook items fields. 

 Synchronization across different Outlook versions (Outlook® 2002, 2003, 2007, 2010)! 

 Synchronize Microsoft Outlook Folders with your own custom forms and imported items. 

 "Read"/"Unread" status synchronization is supported.  You can synchronize your e-mail and see if 
you've already read the message or not. An additional option allows you to enable the 
"read"/"unread" status synchronization for selected Outlook folders. 

 Label (color) synchronization in Outlook Calendar. 

 Synchronization of Master list Categories and individual Categories. 

 Plug2Sync Synchronizer - Microsoft ActiveSync - like interface 

 Easy to use and manage with no requirements of special skills. 

 Intelligent conflict and duplicate detection and management! 

 You can use standard methods to secure your data on your external drive. 
  
*Portable application will be added later in 2010. All users who have purchased non-portable version will 
receive the updated version for free. 
**Microsoft Outlook must be installed on the PC in order to synchronize its data files (PST) 

  
Plug2Sync website  

http://www.plug2sync.com/�
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System Requirements 
 Windows XP/2003/Vista/7 
 Microsoft Outlook* 2002**/2003/2007**/2010 
 Microsoft .NET Framework 2.0 
 RAM 512Mb (1Gb Recommended) 
 CPU 800 MHz (1Ghz Recommended) 

  
ATTENTION: 
*For synchronization of Microsoft Outlook data Microsoft Outlook must be installed on all PCs that you 
plan to sync; for files only synchronization Outlook is not required. 
**It is highly recommended that you update your Outlook with the latest service pack from Windows 
update site; otherwise you may experience Microsoft Outlook crash and other known issues. Latest “Junk 
Filter Updates” are highly recommended for any version of Microsoft Outlook due to some known issues 
with memory leak. 
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Plug2Sync versions 
  

Trial: Fully functional 14-day trial version. 

Full: A fully functional version 

How to buy 

FREQUENTLY ASKED QUESTIONS 

Support 
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Software Update & Activation. 
Click on the underlined links. 

What happens if you don't activate your copy of the product? 

Before you activate the product, you may run it for a limited amount of time (trial version will expire in 14 
days). Afterwards, the program will go into Reduced Functionality Mode. In this Mode you will not be able 
to synchronize updates in the synchronized Folders content. No existing Outlook items or documents will 
be harmed, and you can easily get the program out of this mode by activating it. 

Product Activation: 

1. Connect to the Internet. 

2. Open the Plug2Sync interface. (shortcut is available on your PC Desktop, by double-clicking the 
Plug2Sync icon in the system tray, or from Start->All programs->4Team Corporation-Plug2Sync) 

3. Select -> "Activate..." from Plug2Sync Help menu. 

4. Enter your* Activation Code in the Activation Code field** from Online Activation dialog. 

5. Click Next. 

The program will start functioning as a full version.  
Click here to see the screenshot. 

If you receive the Activation failed dialog, click "< Back" and re-enter your Activation Code. If this does 
not help, go to Support by phone or Live Help at: www.4team.biz 

*The Activation Code will be sent to you by e-mail after you purchase the product. You can purchase the 
product by clicking here. 

**In order to activate the product, you need to purchase it and obtain the activation code. Use "Buy 
online" (Online Activation dialog) to go directly to the product website. 

Software Update 

1. Connect to the Internet 
2. In the Plug2Sync Help menu click About Plug2Sync 
3. Click the "Check for Update" button. 
4. If a new version of the product has been released, remove the old version (Control Panel -> 

Add/Remove Programs) and download and install the new one. 
Note: All your data will be saved and securely translated into a new version. Your Activation Code (your 
order number) may be required. Please click ”Activate” in the product menu and enter the Code. You 
may purchase a group license or separate licenses for each group member or PC from the product 
website. For program activation, the Code has to be entered on each group member’s computer. 

About product activation 

After the trial version period is over, you will need to activate your copy of the program in order to 
continue using it. This wizard will guide you, step-by-step, through the process of activating via the 
Internet or over the telephone. 
Product Activation is an anti-piracy technology designed to verify that software products have been 
legitimately licensed. It is quick, simple, and helps protect customer privacy. 
Product Activation works by verifying that a software activation code, which you must use in order to 
activate the product, has not been used on more personal computers than intended by the software's 
license. 
Note: Please be aware that your Activation (License) Code is linked to your computer(s), and the 
program can be installed only on as many computers as many licenses you have purchased. If you need 
to move the program to another computer, please contact our customer support. 
  
Activation Code will be sent to you by e-mail after you purchase the product. You can purchase it by 
clicking here. 
  

http://www.4team.biz/�
http://www.4team.biz/purchase_plug2sync.asp�
http://www.4team.biz/purchase_plug2sync.asp�
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Getting Started - Installation 
Click on the underline links.   

1. Prior to installation: 
a. You need to have Windows Administrator rights in order to install the product. 
b. *Please check that you are running Microsoft Outlook  2002, 2003, 2007, or 2010 as the Product is 

incompatible with an MS Outlook version prior to 2002; check other System Requirements as 
well. You can update your Outlook version here. 

c. Download the latest version of the product setup file from the 4Team product website or member 
area and distribute among your PCs or team members. 

d. *Make sure you have Microsoft Outlook configured on the desktop computer by opening it. "Personal 
Folders" should be visible in Outlook.  

*required for Outlook synchronization only 

2. Installation (non-Portable*) 

a. Close Microsoft Outlook and all other open programs. 

b. Install Plug2Sync by downloading and opening the "setup" file from the product web site 
http://www.4team.biz/. Installation is required on every computer that you plan to 
synchronize. 

 
Important Notes:  
The Program will start after the Plug2Sync installation is finished if the check box "Launch the 
program" is checked. If, during installation, you receive a message that recommends restarting your 
PC, please proceed with the restart, otherwise Plug2Sync will not be able to work correctly. 

Plug2Sync Flash synchronization setup demo 
You are now ready to start synchronizing your files and Outlook data! Just plug in the USB removable 
drive and proceed with your first synchronization. 

Please refer to the following topics: 

Quick Guide 
  
Our customer support will be happy to answer all your questions regarding our products installation and 
functionality,  by e-mail or through Live Help Chat/Feedback on our Web site at: http://www.4team.biz, over 
the phone at: (954) 796-8161. 
  

Report Problem, Suggestions 
Support 

  
Plug2Sync web site 

http://office.microsoft.com/officeupdate/default.aspx�
http://www.4team.biz/download.asp�
http://www.4team.biz/download.asp�
http://www.sync2.com/demo/�
mailto:support@4team.biz�
http://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1�
http://www.4team.biz/�
http://www.sync2.com/�
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Quick installation and synchronization Guide 
Click on the underlined
1. Check the system requirements 

 links. 
here. 

2. Download the latest version at: http://www.Plug2Sync.com/try_Plug2Sync.asp and save the 
downloaded file to an easy-to-find location. 

3. Install the product by clicking on the downloaded setup file. Follow the installation instructions that 
can be found here. 

4. Prepare a removable drive/device where your synchronized data will be located and make free space 
(The required free space depends on the data size you are going to synchronize. It is highly 
recommended that you have at least 512Mb minimum). 
• USB Flash Drives: Jump Drive, Flash Drive, Sticks, ThumbDrive, etc... - slow speed 

• Flash memory Cards: Memory Stick all versions, Secure Digital Card (SD), etc... 

• External Hard drives (HD) - best speed and security 

5. The Program will start after the Plug2Sync installation is finished if the check box "Launch the 
program" is checked. If you canceled it before, you can start it by clicking the Plug2Sync shortcuts 
available from your computer's desktop or Start -> All Programs -> 4Team Corporation -> 
Plug2Sync. 

6. Plug in the USB removable drive. On the main Plug2Sync window, a message will appear suggesting 
that you establish synchronization with the plugged-in device. 

7. *Select data you want to synchronize by checking boxes near each data type icon (My Outlook data, 
My Documents, My Favorites, My Pictures, My Music, ect.). 

8. Navigate to "What I Sync" and explore. 

9. Click on the "Sync Now" button. Plug2Sync will start synchronization immediately. By default, all of 
the Microsoft Outlook folders within the default Personal Folders and default files folders will be 
synchronized with the removable drive.  
Note: If you have large files and you select all your available data (over 1Gb of data) your first 
synchronization can take hours and will require large free space on the external drive. If you do not 
have that amount of time, we recommend that first you only sync those folders that you really want. 
Later, when you have more time, you can add more folders to be synchronized. Since all the 
synchronized data will be located on your external device (backup), the more folders you add to 
sync, the larger is the size of free space that you will need on the device. 

10. When synchronization is complete, safely remove the drive and go to another computer. 

11. Repeat the same steps. 

12. The following two main scenarios may occur next: 

a. If Outlook and file folders on the next synchronized PC are empty and you choose not to add more 
data to sync with the 1st PC, your first synchronization is complete. 

b. If you have different data in the synchronized folders or you add more data to sync on your 
second PC, you will need to return to your first synchronized PC to perform the final 
synchronization to make all folders identical. And after that your first synchronization is complete. 

13. Your synchronization is complete. Now all your updates and changes in synchronized Outlook and 
file folders will be in sync with other PCs. 

 Click here to learn more about the first synchronization and how to set it up. 

*This step will be required in the upcoming version where file synchronization will be functional. For the 
current release only Outlook data is pre-selected and can’t be unchecked.  

http://www.plug2sync.com/try_plug2sync.asp�
http://en.wikipedia.org/wiki/USB_flash_drives�
http://en.wikipedia.org/wiki/Memory_cards�
http://en.wikipedia.org/wiki/Memory_cards�
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Working with Product 
Accessing Plug2Sync application  
Click on the underlined

Plug2Sync application can be accessed in one of the following ways: 

 links to find out more. 

• By going to Windows Start menu All Programs, selecting 4Team Corporation -> Plug2Sync; 

 
  

• By double-clicking the Plug2Sync icon  in the taskbar notification area 

 
  

• By clicking the Plug2Sync shortcut icon from your desktop: 

 
  

 Main Plug2Sync window 
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Main Plug2Sync window and tray icon 
Click on the underlined
  

 links to find out more. 

The main Plug2Sync dialog is designed to easily navigate through the main application functions, and has 
the following components: 

 
You can perform the desired actions by clicking menu items on the Plug2Sync Synchronizer menu bar 

and selecting one of the following commands from the drop-down menus: 
• File Menu 

 Close - closes the Plug2Sync main window. 
 Exit Plug2Sync - closes this dialog and application. 

Important Note: When you exit the application, synchronization won't start according to 

schedule. If you just want to close the Plug2Sync main window, click  the "X" button   
available in the right-hand upper corner or use the Close function. 

• Tools Menu 
 Show Icon in Tray - keeps the application in the windows system tray to help you access all 

important options, get notifications and have access to a quick start of the main dialog. 
 Options... - adjusts settings related only to synchronization with a currently connected and 

selected external memory device. Options are not available if the external device that you 
synchronize or plan to sync is not connected to this PC and not selected. The program 
automatically assigns options to each external memory device. 

• Actions Menu 
 Sync Now - starts synchronization of the selected data from your PC with the selected external 

device. 
 Stop Sync - stops synchronization with the selected external memory device 
 Safely remove [selected drive name] - USB device manager that helps you remove 

(dismount) your USB external device without data loss. You can also use the Windows eject or 
"Safely remove..." function of Plug2Sync safely remove function instead. 

• Help Menu 
 Plug2Sync Help - accesses the Plug2Sync Help Documentation 
 Report a problem - sends report of a problem to 4Team support along with the log files. 
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 Activate - activates (registers) your license, which  turns the trial into a fully functional version 
 About Plug2Sync - provides access to additional actions, such as: "Check for updates", "Report 

a Problem" along with sending the log files, "Tech Support" - link to an online support form; "Buy 
online" - a direct link to the web page to purchase additional licenses or updates, "Activate" - to 
activate your full version 

  
• The Plug2Sync toolbar allows you to quickly access the most frequently used actions by clicking on 

the appropriate button: 

 
• The support messages help you to choose the next action or warn you about actions that are not 

recommended. 
 Possible messages: 
 Click "Sync Now" to establish partnership and start synchronization 
 Please plug in a removable drive or select a location 
 Do not unplug the [Device Name] ([Drive letter]:) - appears during the synchronization process. 

Please use the Stop button to stop the process and then safely remove your device. 
   Plug2Sync and device partnership status: 

 Not Connected - the device is not connected 
 Connected - the device with established partnership is connected and ready to sync. 
 Ready to establish partnership - you can adjust synchronization settings select data to sync and 

click "Sync now" 
 Synchronizing...[%] - the status of synchronization process and percentage 
 Failed to synchronize - synchronization of the selected device has failed 

 Device management (click on the button to access the menu): 
 Safely remove [selected drive name] - USB device manager that helps you remove (dismount) 

your USB external device without data loss. You can also use the Windows eject or "Safely 
remove..." function instead. 

 List of available drives - if you have several connected drives, you can switch between them 
  
• The Data Selection table allows you to quickly select available data folders include them into 

synchronization and explore them by simply navigating your mouse over the data folders. 
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• Plug2Sync tray icon helps you to quickly access frequently used actions, such as: 

• Open Plug2Sync - opens the main Plug2Sync window 
• Do not Show This Tray Icon - hides icon from the tray, while the program is still running in 

memory 
• Stop Sync - stops synchronization with the selected external memory device 
• Sync Now -> - starts synchronization 
• Exit - closes the Plug2Sync application (removes it from PC memory) and hides the tray icon. 

Important Note: If you are just planning to close (hide) the Plug2Sync main dialog window, click 

 the "X" button available in the right-hand upper corner. 
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Synchronization setup 
Configure synchronization 

Click on the underlined
  

 links to find out more. 

The First synchronization steps: 

1. The Program will start after the Plug2Sync installation is finished if the check box "Launch the 
program" is checked. If you canceled it before, you can start it by clicking the Plug2Sync shortcuts 
available from your computer's desktop or Start -> All Programs -> 4Team Corporation -> 
Plug2Sync. 

2. Plug in the USB removable drive to your PC. On the main Plug2Sync window, a message will 
appear suggesting that you are ready to establish synchronization partnership with the plugged-in 
device. You will also receive a Plug2Sync balloon notification from the Windows system tray taskbar. 

3. *Select data you want to synchronize by checking boxes near each data type icon (My Outlook 
data, My Documents, My Favorites, My Pictures, My Music, ect.). 

4. Navigate to "What I Sync" for each selected data and explore. From the dialog "...Data 
synchronization Settings" select data folders to sync by checking off boxes near each chosen data 
folder. 

5. Click Advanced

6. 

 to setup other synchronization settings and filters. Click "OK" to close "...filters" 
and "...Data synchronization settings" dialogs. 

Click the "Sync Now" button to start synchronization. If no filters or additional data are 
selected, the synchronization process will start with the default selected data and settings. By 
default, all of the Microsoft Outlook folders within the default Personal Folders and default files folders 
will be synchronized with the removable drive.  
Note: If you have large files and you select all your available data (over 1Gb of data) your first 
synchronization can take hours and will require large free space on the external drive. If you do not 
have that amount of time, we recommend that first you only sync those folders that you really want. 
Later, when you have more time, you can add more folders to be synchronized. Since all the 
synchronized data will be located on your external device (backup), the more folders you add to 
sync, the larger is the size of free space that you will need on the device.  
Please do not unplug your USB Device during synchronization. 

7. When synchronization is complete, you can adjust other options (scheduling, application behavior, 
etc.) from the settings dialog available from the Plug2Sync Tools menu.  
Note: All the selected settings are linked to each USB drive and available only if the drive is 
connected to PC. If you want to synchronize the same data set with different filters with different 
PCs, you should use another drive. 

8. You can leave the USB drive plugged-in if you plan to work on this PC. By default, the 
synchronization schedule selected as "Instant" (recommended) means that all changes in the 
selected data folders will be automatically and instantly synchronized with your drive, and you are 
able to unplug the drive anytime you want. 

9. After you finish your work on this PC, you can safely remove the drive by clicking the drive button 
on the main Plug2Sync window or using the standard Windows eject methods. Before doing that, 
check if the Plug2Sync tray icon  is not rotating. 

10. Unplug USB drive from your PC. 

11. Go to another computer. Install Plug2Sync. 

12. Repeat steps 1-7. The following two main scenarios may occur next: 

a. If Outlook and file folders on the next synchronized PC are empty and you choose not to 
add more data to sync with the 1st PC, your first synchronization is complete. 
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b. If you have different data in the synchronized folders or you add more data to sync on 
your second PC, you will need to return to your first synchronized PC to perform the final 
synchronization to make all folders identical. And after that your first synchronization is 
complete. 

13. Your synchronization is complete. Now all your updates and changes in synchronized Microsoft 
Outlook and file folders will be in sync with other PCs. 

 Accessing application 

 Synchronization Filters 

 Options 

 Synchronize Microsoft Outlook 

  

*This step will be required in the upcoming version where file synchronization will be functional. For the 
current release only Microsoft Outlook data is pre-selected and can’t be unchecked. 
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Synchronize Microsoft Outlook  

Click on the underlined
  

 links to find out more. 

Plug2Sync can synchronize all or selected Microsoft Outlook data (Calendar, Contacts, E-mail, Task, 
Notes, etc.) between PCs where the Plug2Sync software is installed.  
How it works: This powerful state-of-the-art application for Microsoft® Outlook® works directly with 
Windows MAPI without interference with Outlook. The system works without a central server or database 
and their role is played by the shared PST file (Outlook Personal Storage Table file) that is placed onto 
your external memory device (e.g.: USB Flash, memory cards, USB external drives, etc). A PST file stores 
all* your Outlook information and folders. Each computer with Microsoft Outlook has its own .PST file to 
store Outlook information in its folders. In order to synchronize Microsoft Outlook data you need to install 
Plug2Sync on all PCs that you plan to synchronize. Plug2Sync will detect any changes made in Outlook 
and publish them in the shared PST file on the connected external drive. When connected to the other 
PCs, Plug2Sync will then pick up the newly synchronized Outlook data from the shared pst file, collected 
and published by Plug2Sync from other PCs, compare it to avoid conflicts and duplicates, and add this 
data to your PC (Outlook). 
  
How to synchronize Outlook between PCs: 
To synchronize all or selected Microsoft Outlook folders between two or more PCs, you need to do the 
following: 
1. Download the Plug2Sync setup file and install the program on all PCs that you wish to synchronize. 
2. Prepare a removable drive/device where your synchronized data will be located and make free space 

(The required free space depends on the data size you are going to synchronize. It is highly 
recommended that you have at least 2Gb or more for synchronization of the whole Microsoft 
Outlook). 

3. Plug in the USB removable drive into your PC. 
4. Click on the "Sync Now" button to start synchronization. Synchronization can last minutes or hours 

depending on the amount of data you select to sync.  
5. After synchronization is finished, unplug USB drive from your PC. 
6. Go to another computer. Repeat steps 1-4. 
  
For more detailed information please refer to the following topics: 

 How it Works 
 Installation 
 Quick Guide 
 Configure synchronization 

  
Please contact our support and sales personal if you have any questions. We are ready to help you install 
and use our software. Click here for contact information. 

http://www.plug2sync.com/try_plug2sync.asp�
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Synchronization Filters  

Click on the underlined
  

 links to find out more. 

Overview: 
Synchronization filters can be applied to each folder type. They will allow you to synchronize the only 
Outlook data that actually needs to be synchronized. If you do not change filters, the default filters will 
automatically apply during synchronization. 
  
Why would I need the synchronization filters? 
Without filters (clear filters) all data of the selected folders during synchronization will be published in the 
connected external drive. In most cases it is not necessary and makes the first synchronization 
complicated (e.g. you decide to synchronize the Inbox folder with 3000 e-mails that include attachments, 
etc... with the data size of 100Mb and more. If you perform the synchronization of folders with many 
(>1'000) items with large attachments (i.e. e-mails) using the USB Flash drive, this may take many hours 
to publish all your synchronized data for the first time and even more time to synchronize it to the second 
PC.) 
  
Access: You can access the filters in the following way: 
1. by clicking "What I Sync" of the selected data folder and "Advanced

2. Tools->Options menu, Synchronization Options tab, by selecting the appropriate data folder button 
and "Advanced" in the "... Data Settings and Filters" dialog. 

" in the "... Data Settings and 
Filters" dialog. 

  
Management (Microsoft Outlook only): 
• Exclude private items - If you synchronize your Outlook folders with your coworkers or friends, you 

probably want to exclude your private e-mails, events and contacts information. If this option is 
selected, all items that are marked Private will be excluded from synchronization 

• Exclude events that are more than ... months old - choose how old the Calendars data that you 
want to synchronize is 

• Exclude e-mails that where received or sent more than ... months ago - choose how old the 
e-mail messages data that you want to synchronize is. 

• Exclude items with the specified categories only: - You can here select what categories of the 
items should be excluded in the synchronization process 

• "Set to Default"- restores the default filter settings 
  
To save the chosen filter settings, click "OK". 
  

 
Other Filters Dialogs (Click to view): 
• Contacts Filters 
• E-mail Filters 
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• Journal Filters 
  
Outlook Data Settings and Filters Dialog: 
This dialog allows you to set synchronization filters for each Outlook data type folder. 
• If the "Allow selection of all Outlook data files (PST) in the profile" checkbox is selected, all available 

Outlook data storage files in the current Outlook profile will be visible in the "Outlook Data 
Synchronization Settings" dialog, and they will be available for synchronization. 

• If the "Allow selection of Outlook data files in other Outlook profiles" checkbox is selected, and there 
are other Outlook profiles configured in the current Windows user account, they will be visible in the 
"Outlook Data Synchronization Settings" dialog, and Outlook folders from these profiles will also be 
available for synchronization. 

  
 Options 
 Synchronization Schedule 
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Synchronization Schedule 

Click on the underlined
  

 links to find out more. 

Synchronization scheduling options allow configuring of how often Plug2Sync will be starting the 
synchronization process. 
3 different schedule modes are available to choose from: 
• Instantly. When this mode is selected, the application will start the full synchronization process each 

time the drive becomes available. Also, when the drive is connected, all further changes that you 
make will be automatically synchronized immediately when they are detected by the application. This 
mode requires a little bit more of your computer resources, but ensures that you always have the 
latest version of your file and/or Outlook data on the device. When this mode is enabled, you are not 
required to manually start the full synchronization process before you unplug your removable drive. 

• Automatically (by schedule). With this mode, the instant synchronization of data updates is 
disabled, and the full synchronization of data will only start in accordance with the selected schedule 
(Hourly, Daily, Weekly, Monthly). This mode is recommended in case you don’t want the updates to 
be applied instantly each time you make them, but you need them to be auto-synchronized 
periodically. When this mode is enabled, it is still recommended that you start the full synchronization 
manually before unplugging your removable drive, otherwise you can’t be sure your latest data 
updates have already been synchronized with the drive.  
Note: Please note that synchronization by schedule can only be started when the application is 
running. 

• Manually. With this mode, synchronization with the removable drive can only be run manually. This 
is not recommended, unless you want to control your synchronization manually each time you 
connect your removable drive. 

  
 Configure synchronization 
 Options 
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Synchronizing Folders (How to) 
How to START synchronization process  

Click on the underlined
  

 links to find out more. 

Overview: 
Each external drive used for synchronized storage has its own synchronization schedule for each PC to 
which it is connected. The schedule can be changed from within the Plug2Sync options when the drive is 
connected to the synchronized PC. 
  
Start the synchronization process. There are three methods of how you can start synchronization 
and they depend on the synchronization schedule you have chosen: 
• Automatically, by plugging your USB drive into a PC. Synchronization will start automatically if 

the Instant synchronization mode is chosen for this PC. 
• Manual synchronization, accessible from the right-click menu on the Plug2Sync tray icon: Click "Sync 

Now" 

 
  
• Manual synchronization, accessible from the main Plug2Sync window toolbar: click the "Sync Now" 

button 

 
  
Note: Without filters, the first synchronization may take hours to finish. 
  

 Configure synchronization 
 Synchronization Schedule 
 stop the synchronization process 
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How to stop synchronization  

Click on the underlined
  

 links to find out more. 

• From the main Plug2Sync window: 

Click "Stop" on the toolbar  
  
• From the right-click menu on the Plug2Sync tray icon: Click "Stop Sync". 

 
  

 start synchronization 
  



Support 

25 

How to add folders to existing synchronization  

Click on the underlined

If you decide to add an Outlook or file folder to existing synchronization: 

 links to find out more. 

  
1. Navigate to "What I Sync" for each selected data and explore. In the dialog "...Data synchronization 

Settings" mark check boxes near the folders to be synchronized. 
2. Click "OK" 
The program will automatically synchronize all the selected data changes. 
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Remove folders from existing synchronization 

If you decide to remove/add an Outlook or file folder from existing synchronization: 
  
1. Navigate to "What I Sync" for each selected data and explore. From the dialog "...Data 

synchronization Settings" deselect check boxes near the folders to be excluded from 
synchronization. 

2. Click "OK" 
The program will automatically remove all deselected folders. 
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Duplicate management  
Overview: 
Since Plug2Sync works without a central server, and the same data may be changed on different PCs 
prior to synchronization, it is very likely that you may have conflicts. 
During the first synchronization on the second PC, or as a result of synchronization with your PDA, Palm 
or similar devices, some data may duplicate. 
In Plug2Sync, we implemented the sophisticated and automated solutions to manage both duplicates and 
conflicts. Unfortunately it is not always possible to determine and merge duplicate items automatically; 
some of them will be left in the data folder. But you will be able to manage them later manually or with 
advanced tools. 
For advanced duplicate management, we recommend "Duplicate Killer". Learn more about this tool by 
clicking here. We offer it for a discounted price for all Plug2Sync owners. For more information, contact 
our Sales here. 
 

http://www.duplicatekiller.com/�
http://www.duplicatekiller.com/�
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Options  
Click on the underlined
  

 links to find out more. 

The Options are accessible from the Plug2Sync main window Tools menu. 
  
The Options dialog consists of tree tabs: Synchronization Schedule, Synchronization Options, Other 
Options. 
  
Synchronization Options: 

 
• "File Folders" Section: 
Here you can adjust the synchronization filters to make sure you only synchronize what you need with the 
removable drive on the current computer. 
• "Outlook Data" Section: 
The "Outlook Data Folders and Filters…" button opens the "What I Sync" dialog, where you can choose 
what Outlook folders to be synchronized on the current computer with the currently selected removable 
drive. 
In this view, the current computer and removable drive Outlook folders are shown in the combined view. 
The folder to be synchronized with the drive should be checked. 
Use the "Show only items marked for synchronization" checkbox to switch between all folders available or 
only folders already selected for synchronization. 
The "Advanced" link will open the "Outlook Data Settings and Filters" dialog. 
• "Created and Deleted Items" Section 
These options control the application's behavior during synchronization of new items added to the 
synchronized data, or data deletion that occurs in the synchronized data. 
  
Other Options: 
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• "Start/Display Options" Section 
Here you can choose if Plug2Sync should be started automatically when you log on to Windows, and if 
Plug2Sync icon should be visible in the Windows notification area on the taskbar. 
• "Mapping of Folders" Section 
Here you can choose how added custom file folders should be synchronized on the current computer.  
When a custom file folder is to be synchronized on one of the devices, Plug2Sync offers the following 
options to place this folder on the computer: 
o If the option "Try keeping the original location (including drive letter), if unable, use the specified 

custom folder" is selected Plug2Sync will try to find the same original location on the current 
computer. If such location cannot be found, or it is inaccessible for synchronization, a specified 
custom folder will be used to place this folder (see "Custom Folder Settings"). 

o If the option "Keep original location, but use the following drive" is selected, Plug2Sync will create 
the folder with the same path as on the original computer, but in the selected drive. 

o If the option "Do not try keeping the original location, always use the specified custom folder" is 
selected, Plug2Sync will create the folder in the specified custom folder (see "Custom Folder 
Settings"). 

Custom Folder Settings: 
In this dialog, the location of custom file folders is set for each data type section. Plug2Sync will create 
folders in these selected locations for all file folders that are added to the synchronized removable drive 
on the other computers. 
  

 Synchronization Schedule 
 Synchronization Filters 
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FAQ, Tips and Troubleshooting 
FREQUENTLY ASKED QUESTIONS (Troubleshooting) 

Click on questions and underline links. We suggest that you use "Search" to quickly find your answers. 

1. Do Distribution Lists propagate to other PCs? 
Yes, Distribution Lists propagate to other synchronized PCs. 

2. Do I initiate synchronization from one computer or from all? 

You should initiate synchronization from one computer. Once the initial synchronization is successful, you 
can start synchronizing other PCs by connecting the same external drive. 

3. Does Plug2Sync synchronize category lists? 

No, Plug2Sync can not synchronize Outlook master category lists. 

4. I have synchronized my Outlook folders, but only some items were synchronized. How do I 
synchronize all items? 
By default Plug2Sync has filters for synchronization. You might want to remove them in Plug2Sync> 
Tools>Options>Synchronization Options tab. Select each data folder that you synchronize and Edit 
Filter you need.  

5. Can I synchronize any synchronized folder with my PDA or Pocket PC? 
Any folder synchronized with Plug2Sync can be synchronized with PDA or Pocket PC. But usually the 
synchronization software (e.g. Microsoft ActiveSync) allows synchronizing only standard Outlook folders, 
i.e. Calendar, Contacts, Tasks, Inbox and Notes. You can’t synchronize any other folders or sub-folders. 

6.   Do flags propagate to other users (PCs) along with items? 
Yes, flags do propagate. 

7. Do attachments propagate to other users (PCs) along with items? 
Yes, attachments are also synchronized along with any Outlook item that supports attachments. 

8. Can I synchronize my Inbox or Sent Items folders using Plug2Sync? 
Yes, you can synchronize the standard Outlook mail folders (Inbox, Sent Items). 

9. Can I use Outlook Rules? 
Yes, you can. But you can't synchronize Rules using Plug2Sync. 

10. We have created custom forms in Outlook. Can we synchronize information using these forms? 
Yes, the program supports synchronization of custom forms. 

  

Report Problem, Suggestions 

Support 
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How to buy/ Register / TRIAL VERSION EXPIRED 
How to continue trial 

Your trial version expires in 14 days. 

If you do not renew (activate) the trial version that is about to expire, you will not be able to use 
program. It is necessary to purchase the license to make the program work without any limitation. 

Buy Now and you will receive: 

• 1 year of free updates. 

• 1 year of free tech support via e-mail and live help. 

  

Click here to Buy Plug2Sync. 

(http://www.4team.biz/purchase_plug2sync.asp) 

  

Have a Question? 

Please call: +1 (954) 796-8161 or click here to Ask Question Now. 

FREQUENTLY ASKED QUESTIONS 

Product Activation 

Support 

  

http://www.4team.biz/purchase_plug2sync.asp�
http://www.4team.biz/purchase_plug2sync.asp�
http://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1'%20target='chat12138912&sessionkey=H4659946961740398489K4129059�
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UNINSTALL 
1. Close Microsoft Outlook. 

2. Go to Start -> Control Panel -> Add or Remove Programs 

3. Find 4Team Plug2Sync and click "Remove". 

Support 

Report Problem, Suggestions 
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Report Problem, Suggestions 
• By Online Support Form. 

• By ”Live Help” at www.4team.biz. 

• Support by email at: support@4team.biz 

• Sales by e-mail at: sales@4team.biz 

• By telephone at: +1 (954) 796-8161. 

  

http://www.4team.biz/support_form.asp�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1'%20target='chat12138912&sessionkey=H4659946961740398489K4129059�
http://www.4team.biz/�
mailto:support@4team.biz�
mailto:sales@4team.biz�
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Support 
Troubleshooting and Support procedure (Get Support): 

1. Make sure that you are running the latest version of the product on all your members or personal PCs. 
You can download the latest product release by clicking here. 

2. Update your Office/Outlook with the latest updates that improve the stability and security of 
Microsoft Office. Click here to go to Microsoft Outlook Office Online website. 

3. Check Systems Requirements. 

4. Refer to Installation procedure. 

5. Search the product FAQ. 

6. Contacting Support: If you cannot solve your problem by any of the previous steps then please send 
the Bug Report e-mail (Outlook Help -> About Product -> Bug Report) to support@4team.biz, or submit 
the Online Support Form, or use LiveHelp with the following information: 

• A detailed description of the problem. Include the steps you have taken to attempt to solve the 
problem already and, where appropriate, the steps to take in order to repeat the problem. 

• The Product version that you are running (Plug2Sync Help menu -> About Plug2Sync). 

• The Microsoft Outlook version that you are running (Outlook Help -> About Microsoft Office Outlook). 

• The operating system and Office/Outlook version of the computer running the product. 

• Screenshots if available (press "Print Scr" on the keyboard and paste (Ctrl + V) to the Word or any 
available picture editor). 

Note: Please remember to keep all of the conversation history when you reply to our emails. 

Click here to submit the Online Support Form. 

  

We provide full support for trial and full version of Plug2Sync for Microsoft Outlook: 

• By Online Support Form. 

• By "Live Help" at www.4team.biz. (this is the fastest method) 

• By e-mail at: support@4team.biz 

• By telephone at: +1 (954) 796-8161. (only simple questions like product functionality, activations 
problems, sales questions) 

  

To buy the license if your team grows, please click here.* 

Be sure that your computer is online if you want to use this page for orders and support. 

• All our customers who purchased the program or added a new license are eligible to get free updates 
for one year from the last purchase date. 

• If you are looking for other 4Team products for Microsoft Outlook, you can get them at significantly 
discounted prices; just send us an e-mail with your order number, product name, and number of 
licenses that you wish to purchase. 

  

!!! Note: We do not provide support for Microsoft Outlook; please refer to the resources at Microsoft web site. 

* Be sure that your computer is connected to the Internet if you want to use this page for orders and support. 

  

 

http://www.4team.biz/download.asp�
http://office.microsoft.com/officeupdate/default.aspx�
mailto:support@4team.biz�
http://www.4team.biz/support_form.asp�
http://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1�
http://www.4team.biz/support_form.asp�
http://www.4team.biz/support_form.asp�
http://www.4team.biz/support_form.asp�
https://server.iad.liveperson.net/hc/12138912?cmd=file&file=visitorWantsToChat&site=12138912&byhref=1'%20target='chat12138912&sessionkey=H4659946961740398489K4129059�
http://www.4team.biz/�
mailto:support@4team.biz�
http://www.4team.biz/purchase_plug2sync.asp�
http://support.microsoft.com/�
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